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1.1 Debugger

1 User's Guide

Debugger isagraphical tool which can be used for debugging and testing of Erlang programs. For exampl e, breakpoints
can be set, code can be single stepped and variable values can be displayed and changed.

1.1 Debugger

1.1.1 Introduction

Debugger isagraphical user interfacefor the Erlang interpreter, which can be used for debugging and testing of Erlang
programs. For example, breakpoints can be set, code can be single stepped and variable values can be displayed and
changed.

The Erlang interpreter can also be accessed via the interface module i nt , seeint(3).

Warning: Note that the Debugger at some point might start tracing on the processes which execute the interpreted
code. This means that a conflict will occur if tracing by other meansiis started on any of these processes.

1.1.2 Getting Started with Debugger

Start Debugger by calling debugger : start (). It will start the Monitor window showing information about all
debugged processes, interpreted modules and selected options.

Initially there are normally no debugged processes. First, it must be specified which modul es should be debugged, or
interpreted asit isalso called. Thisisdone by choosing Module->Interpret... in the Monitor window and then selecting
the appropriate modules from the Interpret Dialog window.

Note:

Only modules compiled with the option debug_i nf o set can be interpreted. Non-interpretable modules are
shown within parenthesis in the Interpret Dialog window.

When amoduleisinterpreted, it can be viewed in a View Module window. Thisis done by selecting the module from
the Module->modul e->View menu. The contents of the source fileis shown and it is possible to set breakpoints.

Now the program that should be debugged can be started. This is done the normal way from the Erlang shell. All
processes executing code in interpreted modules will be displayed in the Monitor window. It is possible to attach to
one of these processes, by double-clicking it, or by selecting the process and then choosing Process-> Attach.

Attaching to a process will result in a Attach Process window being opened for this process. From the Attach Process
window, it is possible to control the process execution, inspect variable values, set breakpoints etc.
1.1.3 Breakpoints and Break Dialogue Windows

Once the appropriate modules are interpreted, breakpoints can be set at relevant locations in the source code.
Breakpoints are specified on aline basis. When a process reaches a breakpoint, it stops and waits for commands (step,
skip, continue,...) from the user.
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Note:

When a process reaches a breakpoint, only that processis stopped. Other processes are not affected.

Breakpoints are created and del eted using the Break menu of the Monitor window, View Module window and Attach
Process window.

Executable Lines

To have effect, a breakpoint must be set at an executable line, which is a line of code containing an executable
expression such asamatching or afunction call. A blank line or aline containing acomment, function head or pattern
inacase-orrecei ve statement is not executable.

In the example below, lines number 2, 4, 6, 8 and 11 are executable lines:

1: is_| oaded( Modul e, Conpi |l ed) ->

2 case get_fil e(Mdul e, Conpi | ed) of
3 {ok,File} ->

4: case code: whi ch(Mobdul e) of
5: ?TAG - >

6 {| oaded, Fi | e};

7 _->

8: unl oaded

9: end;

10: fal se ->

11: fal se

12: end.

Status and Trigger Action
A breakpoint can be either active or inactive. I nactive breakpoints are ignored.
Each breakpoint has atrigger action which specifies what should happen when a process has reached it (and stopped):

* enable Breakpoint should remain active (default).
« disable Breakpoint should be made inactive.
* delete Breakpoint should be deleted.

Line Breakpoints
A line breakpoint is created at a certain line in amodule.

—| Line Break E |J|

Module:fms

L1'ne:|

Trigger Action
¥ Enable
~ Disable

Cancel |

~ Delete ok

Figure 1.1: The Line Break Dialog Window.
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Right-clicking the Module entry will open a popup menu from which the appropriate module can be selected.

A line breakpoint can also be created (and deleted) by double-clicking the line when the module is displayed in the
View Module or Attach Process window.

Conditional Breakpoints

A conditional breakpoint is created at a certain line in the module, but a process reaching the breakpoint will stop
only if agiven condition istrue.

The condition is specified by the user asamodule name Cvbdul e and afunction name CFunct i on. When aprocess
reaches the breakpoint, CMbdul e: CFunct i on( Bi ndi ngs) will be evaluated. If and only if this function call
returnst r ue, the process will stop. If the function call returnsf al se, the breakpoint will be silently ignored.

Bi ndi ngs is alist of variable bindings. Use the function i nt : get _bi ndi ng( Vari abl e, Bi ndi ngs) to
retrieve the value of Var i abl e (given as an atom). The function returnsunbound or { val ue, Val ue}.

—| Conditional Break | - |J|

Module: Ifac

L1ne:|8

C-Module: Ic_test

C-Function: Ic_br‘eak

Trigger Action
¥ Enable
~ Disable

Cancel

eacer |

~ Delete

Figure 1.2: The Conditional Break Dialog Window.

Right-clicking the Module entry will open a popup menu from which the appropriate module can be selected.

Example: A conditional breakpoint calling c_t est: c_br eak/ 1 isadded at line 8 in the module f ac. Each time
the breakpoint is reached, the function is called, and when Nis equal to 3 it returnst r ue, and the process stops.

Extract fromf ac. erl :

4. fac(0) ->

5. 1;

6.

7. fac(N ->

8. N * fac(N - 1).

Definitionof c_t est: ¢_break/ 1:

-nmodul e(c_test).
-export([c_break/1]).

c_break(Bi ndi ngs) ->
case int:get_binding('N, Bindings) of
{val ue, 3} ->
true;
->
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fal se
end.

Function Breakpoints
A function breakpoint is a set of line breakpoints, one at the first line of each clause in the given function.

—|  Function Break | - |J|

Modulefng

Function||slave_loop/1
slave_pids2
|

slave_replace/z2

start/1 z
R =

4 0k | Cancel |

Figure 1.3: The Function Break Dialog Window.

Right-clicking the Module entry will open a popup menu from which the appropriate module can be selected.

Clicking the Ok button (or 'Return’ or 'Tab") when a module name has been given, will bring up al functions of the
module in the listbox.

1.1.4 Stack Trace

The Erlang emulator keeps track of a stack trace, information about recent function calls. This information is used,
for example, if an error occurs:

1> catch a+l.

{'EXIT ,{badarith,[{erlang,'+ 6 [a, 1]},
{erl _eval , do_apply, 5},
{erl _eval, expr, 5},
{shel | , exprs, 6},
{shel | , eval _exprs, 6},
{shel |, eval _| oop, 3}]1}}

In the case above, the stack trace shows that the function called last was er| _eval : eval _op/ 3. See Erlang
Reference Manual, Errors and Error handling, for more information about stack trace.

Debugger emulatesthe stack trace by keeping track of recently called interpreted functions. (Thereal stack trace cannot
be used, as it shows which functions of the Debugger have been called, rather than which interpreted functions).

This information can be used to traverse the chain of function calls, using the 'Up' and '‘Down' buttons of the Attach
Process window.

By default, the Debugger saves information about all current function calls, that is, function calls that have not yet
returned a value (option 'Stack On, Tail").

This means, however, that information is saved also for tail recursive calls. For example, repeated callsto thel oop
function of an Erlang process. This may consume unnecessary amounts of memory for debugged processes with long
lifetimes and many tail recursive calls. It is therefore possible to set the option 'Stack On, no tail', in which case
information about previous calls are discarded when atail recursive call is made.
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1.1 Debugger

It is also possible to turn off the Debugger stack trace facility (‘Stack Off"). Note: If an error occurs, in this case the
stack trace will be empty.

See the section about the Monitor Window for information about how to change the stack trace option.

1.1.5 The Monitor Window

The Monitor window is the main window of Debugger and shows a listbox containing the names of al interpreted
modul es (double-clicking amodule brings up the View Module window), which options are selected, and information

about all debugged processes, that is all processes which have been/are executing code in interpreted modules.

—| Monitor | -]

File  Edit Module  Process  Break  Options  Windows Help

Ita Pid Initial Call Hame Status Info
<0.30.0> taisd0 idle
<0.43. 03 ta:’-s/0-fun-0-"/0 exit {und
<0.48.0> tar -s/0-fun-0-"/0 waiting

£

| [

huto Attach:

a

a

a

Stack Trace:

On {with tail}

A Back Trace Size: il
100 =

Figure 1.4: The Monitor Window.

The Auto Attach buttons, Stack Trace label and Back Trace Size label show some options set, see Options Menu for
further information about these options.

Process Grid
Pid

The process identifier.
Initial Call
Thefirst call to an interpreted function by this process. (Modul e: Functi on/ Arity)

Name

The registered name, if any. If a registered name does not show up, it may be that the Debugger received

information about the process before the name had been registered. Try selecting Edit-> Refresh.

Satus

The current status, one of the following:

idle

Theinterpreted function call has returned a value, and the processis no longer executing interpreted code.
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running

The process is running.

waiting

The processiswaitinginar ecei ve statement.

break

The processis stopped at a breakpoint.

exit

The process has terminated.

no_conn

There is no connection to the node where the process is located.
Information

Additional information, if any. If the processis stopped at a breakpoint, the field contains information about the
location { Modul e, Li ne} . If the process has terminated, the field contains the exit reason.

The File Menu
Load Settings...

Try to load and restore Debugger settings from a file previously saved using Save Settings..., see below. Any
errors are silently ignored.

Save Settings...

Save Debugger settings to afile. The settings include the set of interpreted files, breakpoints, and the selected
options. The settings can be restored in a later Debugger session using Load Settings..., see above. Any errors
are silently ignored.

Exit
Stop Debugger.

The Edit Menu
Refresh

Update information about debugged processes. Removes information about all terminated processes from the
window, and also closes all Attach Process windows for terminated processes.

Kill All
Terminate all processes listed in thewindow usingexi t (Pid, kill).

The Module Menu
Interpret...
Open the Interpret Dialog window where new modules to be interpreted can be specified.
Delete All
Stop interpreting all modules. Processes executing in interpreted modules will terminate.
For each interpreted module, a corresponding entry is added to the Module menu, with the following submenu:
Delete
Stop interpreting the selected module. Processes executing in this module will terminate.
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View
Open a View Module window showing the contents of the selected module.

The Process Menu

Thefollowing menuitemsapply to the currently selected process, provided it is stopped at abreakpoint. Seethe chapter
about the Attach Process window for more information.

Sep
Next
Continue
Finish
The following menu items apply to the currently selected process.
Attach
Attach to the process and open a Attach Process window.
Kill
Terminate the processusingexi t (Pi d, kil l).
The Break Menu
Theitemsin this menu are used to create and del ete breakpoints. See the Breakpoints chapter for more information.
Line Break...
Set aline breakpoint.
Conditional Break...
Set a conditional breakpoint.
Function Break...
Set a function breakpoint.
Enable All
Enable all breakpoints.
Disable All
Disable all breakpoints.
Delete All
Remove all breakpoints.
For each breakpoint, a corresponding entry is added to the Break menu, from which it is possible to disable/enable or
delete the breakpoint, and to change its trigger action.

The Options Menu
Trace Window

Set which areas should be visible in an Attach Process window. Does not affect already existing Attach Process
windows.

Auto Attach
Set at which events adebugged process should be automatically attached to. Affects existing debugged processes.

e First Call - thefirst time a process calls a function in an interpreted module.
e On Exit - at process termination.
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e On Break - when a process reaches a breakpoint.
Sack Trace

Set stack trace option, see section Stack Trace. Does not affect already existing debugged processes.

*  Sack On, Tail - save information about all current calls.

e Sack On, No Tail - save information about current calls, discarding previous information when atail
recursive call ismade.

e Sack Off - do not save any information about current calls.
Back Trace Sze...

Set how many call frames should be fetched when inspecting the call stack from the Attach Process window.
Does not affect already existing Attach Process windows.

The Windows Menu

Containsamenuitem for each open Debugger window. Selecting one of theitemswill raise the corresponding window.

The Help Menu
Help
View the Debugger documentation. Currently this function requires Netscape to be up and running.

1.1.6 The Interpret Dialog Window

Theinterpret dialog moduleis used for selecting which modulesto interpret. Initially, the window shows the modules
(er | files) and subdirectories of the current working directory.

Interpretable modules are modules for which aBEAM file, compiled with the option debug_i nf o set, can be found
in the same directory as the source code, or in an ebi n directory next to it.

Modules, for which the above regquirements are not fulfilled, are not interpretable and are therefore displayed within
parentheses.

Thedebug_i nf o option causes debug information or abstract code to be added to the BEAM file. Thiswill increase
the size of thefile, and al'so makesit possible to reconstruct the source code. It istherefore recommended not to include
debug information in code aimed for target systems.

An example of how to compile code with debug information using er | c:
% erl c +debug _info nodul e. erl

An example of how to compile code with debug information from the Erlang shell:
4> c(nodul e, debug_i nfo).
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—| Interpret Dialog =

Filter

Ifhnme/guni11a/debugger.newf*.er1

Directories Files
e jns.er1
images
| |
~d [~ K =
Selection

Ifhnme/guni11a/debugger.newfms.er1

o Choose | 811 | Filter | Dione | d

Figure 1.5: The Interpret Dialog Window.

Browse the file hierarchy and interpret the appropriate modules by selecting a module name and pressing Choose (or
carriagereturn), or by double clicking themodule name. Interpreted modul esare displayed with a* infront of thename.

Pressing All will interpret all displayed modulesin the chosen directory.
Pressing Done will close the window.

Note:

When the Debugger is started in global mode (which is the default, see debugger: start/0), modules added (or
deleted) for interpretation will be added (or deleted) on all known Erlang nodes.

1.1.7 The Attach Process Window

From an Attach Process window the user can interact with adebugged process. Onewindow is opened for each process
that has been attached to. Note that when attaching to a process, its execution is automatically stopped.
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Attach Process =0.44 .0 =
File  Edit Process Break Options  Windows Help
State: break [ms.er1/56]
47 jg
48 slave_initiN) >
49 : slawve_Tloop(N].
ol
51: slave_Toop(H) -»
o2: receive
a3: die -
od: ok ;
55: Msg -»
96: --> io:format{"Slave ~p got message ~p~n", [H, Msc
57: slave_Toop(N)
o8 end.
a9:
G0 slave_pid(N, [#slave{pid=Pid, number=H}|_Restl) -»
E1l: Fid;
E2: slave_pid(H, [_5lave|Rest]) —»
£3: slave_pidiN, Rest).
Eid:
ES: slave_replace(Pid, [#slave{pid=Pid, numher=N}|Rest]) -»
GG: io:formati"master restarting dead slave “p™n", [N1J,
7 [#s1ave{pid=spawr_linkims, slave_init, [N1), number=M}|Rest];
£3: slave_replace(Pid, [5lave | Restl) ->
E3: [Slave | slave_replace(Pid, Rest)].
£
P~ -
Hext | Step | Finish |Eunt1nue| Up | Down Where | Break
Hame Yalue
Eva]uatnrﬂ
I Msg hello
H 2
J £ £l
P = ~J I =

Figure 1.6: The Attach Process Window.

The window is divided into five parts:

The Code area, showing the code being executed. The code is indented and each line is prefixed with its line
number. If the process execution is stopped, the current line is marked with -->. An existing break point at aline
is marked with -@-. In the example above, the execution has been stopped at line 56, before the execution of
i o:format/ 2.

Active breakpoints are shown in red, while inactive breakpoints are shown in blue.
The Button area, with buttons for quick access to frequently used functions in the Process menu.

The Evaluator area, where the user can evaluate functions within the context of the debugged process, provided
that process execution has been stopped.

The Bindings area, showing all variables bindings. Clicking on a variable name will result in the value being
displayed in the Evaluator area. Double-clicking on a variable name will open awindow where the variable
value may be edited. Note however that pid, reference, binary or port values can not be edited.
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e The Trace area, showing atrace output for the process.

++ (N) <L>
Function call, where Nisthe cdl level and L the line number.

-- (N

Function return value.

==> Pid : Mg

The message Ms g is sent to process Pi d.
<== N];g

The message Ms g isreceived.

++ (N) receive

Waitinginar ecei ve.

++ (N) receive with tineout
Waitinginar ecei ve. .. after.

Also the back trace, a summary of the current function calls on the stack, is displayed in the Trace area.

It is configurable using the Options menu which areas should be shown or hidden. By default, all areas except the
Trace areais shown.

The File Menu
Close

Close this window and detach from the process.

The Edit Menu
Gotoline...

Go to aspecified line number.
Search...

Search for a specified string.

The Process Menu
Sep
Execute the current line of code, stepping into any (interpreted) function calls.
Next
Execute the current line of code and stop at the next line.
Continue
Continue the execution.
Finish
Continue the execution until the current function returns.
ip
Skip the current line of code and stop at the next line. If used on the last line in a function body, the function
will return ski pped.
Time Out

Simulate atimeout when executing ar ecei ve. . . af t er statement.
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Sop

Stop the execution of arunning process, that is, make the process stop as at a breakpoint. The command will take
effect (visibly) the next time the process receives a message.

Where

Make sure the current location of the execution is visible in the code area.

Kill

Terminate the processusingexi t (Pi d, kil l).
Messages

Inspect the message queue of the process. The queue is printed in the evaluator area.
Back Trace

Display the back trace of the process, a summary of the current function calls on the stack, in the trace area
Requires that the Trace areais visible and that the stack trace option is 'Stack On, Tail' or 'Stack On, No Tail".

Up
Inspect the previous function call on the stack, showing the location and variable bindings.
Down
Inspect the next function call on the stack, showing the location and variable bindings.
The Options Menu
Trace Window
Set which areas should be visible. Does not affect other Attach Process windows.
Sack Trace
Same as in the Monitor window, but does only affect the debugged process the window is attached to.
Back Trace Sze...

Set how many call frames should be fetched when inspecting the call stack. Does not affect other Attach Process
windows.

Break, Windows and Help Menus

The Break, Windows and Help menus look the same asin the Monitor window, see the chapter The Monitor Window,
except that the Breaks menu apply to the local breakpoints only.

1.1.8 The View Module Window

The View Module window shows the contents of an interpreted module and makes it possible to set breakpoints.
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— View Module ms =
File  Edit Break ‘Windows Help
11: jg
12: -exporti[start/l, stop/0, to_slaves/2]).

13: —expartinaster_init/l, slave_init/11).
14:

15: startiN) ->

16: spawnims, master_init, [H1).

17:

18: stop() -»

19: master ! stop.

20:

21: to_slavelMsg, NI -»

22: master ! {to_slave, selfi), Msg, N}.
23z

2d: master_init{H) ->

25: registerinaster, self(l),

26: process_flagitrap_exit, true),

27: master_loop(start_slaves(N, [11).
28:

29: master_loop(3laves) -»

30: receive

31: stop >

32: exitistopped);

33: {to_slave, _Pid, Msg, N} -»

34 slave_pid(N, 5laves) ! Msg, /

P~ =

Figure 1.7: The View Module Window.

The source code isindented and each lineis prefixed with its line number.

Clicking alinewill highlight it and select it to be the target of the breakpoint functions available from the Break menu.
Doubleclicking a line will set a line breakpoint on that line. Doubleclicking a line with an existing breakpoint will
remove the breakpoint.

Breakpoints are marked with -@-.
File and Edit Menus

The File and Edit menus look the same as in the Attach Process window, see the chapter The Attach Process Window.

Break, Windows and Help Menus

The Break, Windows and Help menus look the same asin the Monitor window, see the chapter The Monitor Window,
except that the Breaks menu apply to the local breakpoints only.

1.1.9 Performance

Execution of interpreted code is naturally slower than for regularly compiled modules. Using the Debugger also
increases the number of processes in the system, as for each debugged process another process (the meta process)
is created.

It is also worth to keep in mind that programs with timers may behave differently when debugged. Thisis especially
true when stopping the execution of a process, for example at abreakpoint. Timeouts can then occur in other processes
that continue execution as normal.
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1.1.10 Code Loading Mechanism

Code loading works almost as usual, except that interpreted modules are also stored in a database and debugged
processes usesonly thisstored code. Re-interpreting an interpreted modulewill result inthe new version being stored as
well, but does not affect existing processes executing an older version of the code. This meansthat the code replacement
mechanism of Erlang does not work for debugged processes.

1.1.11 Debugging Remote Nodes
By using debugger : st art/ 1, it can be specified if Debugger should be started in local or global mode.

debugger:start(local | global)

If no argument is provided, Debugger is started in global mode.

In local mode, code is interpreted only at the current node. In global mode, code is interpreted at all known nodes.
Processes at other nodes executing interpreted code will automatically be shown in the Monitor window and can be
attached to like any other debugged process.

It is possible, but definitely not recommended to start Debugger in global mode on more than one node in a network,
as they will interfere with each other leading to inconsistent behaviour.
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2 Reference Manual

Debugger isagraphical tool which can be used for debugging and testing of Erlang programs. For exampl e, breakpoints
can be set, code can be single stepped and variable values can be displayed and changed.
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debugger

debugger

Erlang module

Erlang Debugger for debugging and testing of Erlang programs.

Exports

start ()
start(File)
start (Mode)

start (Mode, File)
Types:
Mode = local | global
File=string()
Starts Debugger.

If given afile name as argument, Debugger will try to load its settings from thisfile. Refer to Debugger User's Guide
for more information about settings.

If given| ocal asargument, Debugger will interpret code only at the current node. If given gl obal as argument,
Debugger will interpret code at all known nodes, thisis the defaullt.

qui ck(Modul e, Nane, Args)
Types:
M odule = Name = atom()
Args=[term()]
This function can be used to debug a single process. The module Mddul e is interpreted and

app! y(Modul e, Nane, Ar gs) iscalled. Thiswill open an Attach Process window, refer to Debugger User's Guide
for more information.
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Erlang module

Themodulei providesshort formsfor some of the functions used by the graphical Debugger and some of the functions
inthei nt module, the Erlang interpreter.

This module also provides facilities for displaying status information about interpreted processes and break points.

It is possible to attach to interpreted processes by giving the corresponding process identity only. By default, an
attachment window pops up. Processes at other Erlang nodes can be attached manually or automatically.

By preference, these functions can be included in the module shel | _def aul t . By default, they are.

Exports

inm() -> pid()
Starts a new graphical monitor. Thisisthe Monitor window, the main window of the Debugger. All of the Debugger

and interpreter functionality is accessed from the Monitor window. The Monitor window displays the status of all
processes that have been/are executing interpreted modules.

i i (AbsModul es) -> ok
ii(AbsModule) -> {nmodule, Mdule} | error
i ni (AbsMbdul es) -> ok

i ni (AbsMbdul e) -> {nodul e, Mdule} | error
Types:
AbsModules=[AbsModule]
AbsModule=Module| File
Module = atom()
File=string()
Interpretsthe specified module(s). i i / 1 interpretsthe module(s) only at the current node, seeint:i/1.i ni / 1 interprets
the module(s) at al known nodes, see int:ni/1.

i q( AbsMbdul e) -> ok

i nq( AbshMbdul ) -> ok
Types:
AbsModule= Module| File
Module = atom()
File=string()
Stops interpreting the specified module. i g/ 1 stops interpreting the module only at the current node. i nq/ 1 stops
interpreting the module at all known nodes.
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i1() -> ok

Makes a printout of al interpreted modules. Modules are printed together with the full path name of the corresponding
source codefile.

ip() -> ok
Makes a printout of the current status of all interpreted processes.

ic() -> ok

Clears information about processes executing interpreted code byt removing all information about terminated
processes.

i aa(Flags) -> true

i aa(Fl ags, Function) -> true
Types.
Flags = [init | break | exit]
Function = {Module,Name,Args}
Module = Name = atom()
Args=[term()]
Sets when and how to automatically attach to a debugged process, seeint:auto_attach/2. Funct i on defaults to the
standard function used by the Debugger.

ist(Flag) -> true
Types:
Flag = all | no_tail | false
Sets how to save call framesin the stack, see int:stack_trace/1.

ia(Pid) -> ok | no_proc
Types.
Pid = pid()
Attaches to the debugged process Pi d. A Debugger Attach Process window is opened for the process.

ia(X,Y,2Z2) -> ok | no_proc
Types:
X=Y=Z=int()
Sameasi a( Pi d) , where Pi d istheresult of calling the shell function pi d( X, Y, Z) .

ia(Pid, Function) -> ok | no_proc
Types:

Pid = pid()

Function = {Module,Name}

Module = Name = atom()
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Attaches to the debugged process Pi d. The interpreter will call spawn( Modul e, Name, [Pid]) (andignore
the result).

ia(X, Y,Z Function) -> ok | no_proc
Types.
X=Y=Z=int()
Function = {Module,Name}
Module = Name = atom()
Sameasi a( Pi d, Functi on), wherePi d isthe result of caling the shell function pi d( X, Y, Z) . An attached

process is expected to call the unofficial i nt : att ached( Pi d) function and to be able to handle messages from
theinterpreter, seedbg _ui _trace. erl for an example.

i b(Modul e, Line) -> ok | {error, break exists}

Types.
Module = atom()
Line=int()

Creates abreakpoint at Li ne in Modul e.

i b(Modul e, Nane, Arity) -> ok | {error, function_not_found}

Types:
M odule = Name = atom()
Arity = int()

Creates breakpoints at the first line of every clause of the Modul e: Name/ Ari t y function.

ir() -> ok
Deletes al breakpoints.

i r(Mdule) -> ok
Types:
Module = atom()
Deletes all breakpointsin Mbdul e.

i r(Modul e, Line) -> ok

Types.
Module = atom()
Line=int()

Deletes the breakpoint located at Li ne in Modul e.

ir(Module, Nane, Arity) -> ok | {error, function_not_found}

Types:
Module = Name = atom()
Arity = int()

Deletes the breakpoints at the first line of every clause of the Modul e: Nare/ Ar i t y function.
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i bd(Modul e, Line) -> ok

Types:
Module = atom()
Line=int()

Makes the breakpoint at Li ne in Modul e inactive.

i be(Modul e, Line) -> ok

Types:
Module = atom()
Line=int()

Makes the breakpoint at Li ne in Modul e active.

i ba(Modul e, Line, Action) -> ok

Types.
Module = atom()
Line=int()

Action = enable | disable | delete
Setsthe trigger action of the breakpoint at Li ne in Modul e to Act i on.

i bc(Modul e, Line, Function) -> ok

Types:
M odule = atom()
Line=int()

Function = {Module,Name}
Name = atom()

Sets the conditional test of the breakpoint at Li ne in Modul e to Funct i on.

The conditional test is performed by calling Modul e: Nanme( Bi ndi ngs) , whereBi ndi ngs isthe current variable
bindings. The function must return t r ue (break) or f al se (do not break). Use i nt : get _bi ndi ng( Var,
Bi ndi ngs) to retrieve the value of avariable Var .

i pb() -> ok
Makes a printout of all existing breakpoints.

i pb(Modul ) -> ok
Types:
Module = atom()
Makes a printout of all existing breakpointsin Modul e.

iv() -> atom)

Returns the current version number of the interpreter. The same as the version number of the Debugger application.

hel p() -> ok
Prints help text.
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Usage
Refer to the Debugger User's Guide for information about the Debugger.

See Also
i nt(3)
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int

int

Erlang module

The Erlang interpreter provides mechanisms for breakpoints and stepwise execution of code. It is mainly intended to
be used by the Debugger, see Debugger User's Guide and debugger ( 3) .

From the shell, it is possible to:

e Specify which modules should be interpreted.

e Specify breakpoints.

«  Monitor the current status of all processes executing code in interpreted modules, also processes at other Erlang
nodes.

By attaching to a process executing interpreted code, it is possible to examine variable bindings and order stepwise
execution. This is done by sending and receiving information to/from the process via a third process, called the
meta process. It is possible to implement your own attached process. See i nt . er| for available functions and
dbg_ui _trace. erl for possible messages.

Theinterpreter depends on the Kernel, STDLIB and GS applications, which means modul es belonging to any of these
applications are not allowed to be interpreted as it could lead to a deadlock or emulator crash. This also applies to
modules belonging to the Debugger application itself.

Breakpoints

Breakpointsare specified on aline basis. When aprocess executing codein aninterpreted modul e reaches abreakpoint,
it will stop. This means that that a breakpoint must be set at an executable ling, that is, aline of code containing an
executable expression.

A breakpoint have a status, atrigger action and may have a condition associated with it. The status is either active or
inactive. An inactive breakpoint isignored. When abreakpoint is reached, the trigger action specifiesif the breakpoint
should continue to be active (enable), if it should become inactive (disable), or if it should be removed (delete). A
condition isatuple { Modul e, Nane} . When the breakpoint is reached, Modul e: Nane( Bi ndi ngs) iscaled. If
thisevaluatestot r ue, execution will stop. If thisevaluatestof al se, the breakpoint isignored. Bi ndi ngs contains
the current variable bindings, use get _bi ndi ng to retrieve the value for agiven variable.

By default, abreakpoint isactive, hastrigger actionenabl e and hasno condition associated with it. For more detailed
information about breakpoints, refer to Debugger User's Guide.

Exports
i (AbsModul e) -> {nodul e, Modul e} | error
i (AbsModul es) -> ok
ni (AbsModul e) -> {nodul e, Modul e} | error
ni (AbsModul es) -> ok
Types:

AbsM odules = [AbsModul€]

AbsModule=Module | File| [Module| Filg]
Module = atom()
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File=string()

Interprets the specified module(s). i / 1 interprets the module only at the current node. ni / 1 interprets the module
at al known nodes.

A module may be given by its module name (atom) or by its file name. If given by its module name, the object code
Modul e. beamis searched for in the current path. The source code Modul e. er | is searched for first in the same
directory asthe object code, theninasr ¢ directory next toit.

If given by its file name, the file name may include a path and the . er | extension may be omitted. The object code
Mbdul e. beamis searched for first in the same directory as the source code, then in an ebi n directory next to it,
and then in the current path.

Note:

The interpreter needs both the source code and the object code, and the object code must include debug
information. That is, only modules compiled with the option debug_i nf o set can be interpreted.

The functionsreturns { nodul e, Modul e} if the module was interpreted, or er r or if it was not.

The argument may also be a list of modules/file names, in which case the function tries to interpret each module as
specified above. The function then always returns ok, but prints some information to stdout if a module could not
be interpreted.

n( AbsModul e) -> ok

nn( AbsModul ) -> ok

Types.
AbsModule=Module | File| [Module| Filg]
Module = atom()
File=string()

Stops interpreting the specified module. n/ 1 stops interpreting the module only at the current node. nn/ 1 stops
interpreting the module at all known nodes.

Asfori/ 1 andni/ 1, amodule may be given by either its module name or its file name.

interpreted() -> [ Mdul €]
Types:

Module = atom()
Returns alist with all interpreted modules.

file(Mdule) -> File | {error,not_| oaded}

Types:
M odule = atom()
File=string()

Returns the source code file name Fi | e for an interpreted module Modul e.
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i nterpretabl e(AbsMdule) -> true | {error, Reason}
Types:
AbsModule=Module | File
M odule = atom()
File=string()
Reason = no_src|no_beam | no_debug_info | badarg | {app,App}
App = atom()

Checks if amodule is possible to interpret. The module can be given by its module name Modul e or its source file
nameFi | e. If given by a module name, the module is searched for in the code path.

Thefunction returnst r ue if both source code and object code for the module isfound, the module has been compiled
with the option debug_i nf o set and does not belong to any of the applications Kernel, STDLIB, GS or Debugger
itself.

Thefunctionreturns{ er r or , Reason} if the module for some reason is not possible to interpret.

Reasonisno_sr c if no source codeisfound or no_beamif no object codeisfound. It is assumed that the source-
and object code are located either in the same directory, or in sr ¢ and ebi n directories next to each other.

Reasonisno_debug_i nf o if the module has not been compiled with the option debug_i nf o set.

Reason isbadar g if AbsModul e isnot found. This could be because the specified file does not exist, or because
code: whi ch/ 1 does not return a beam file name, which is the case not only for non-existing modules but aso for
modules which are preloaded or cover compiled.

Reason is{app, App} where App iskernel , stdlib, gs or debugger if AbsMbdul e belongs to one of
these applications.

Note that the function can return t r ue for a module which in fact is not interpretable in the case where the module
is marked as sticky or resides in a directory marked as sticky, as thisis not discovered until the interpreter actually
triesto load the module.

auto_attach() -> false | {Fl ags, Functi on}
auto_attach(fal se)

aut o_attach(Fl ags, Function)
Types:
Flags = [init | break | exit]
Function = {Module,Name,Args}
M odule = Name = atom()
Args=[term()]
Getsand setswhen and how to automatically attach to aprocess executing code in interpreted modules. f al se means
never automatically attach, thisis the default. Otherwise automatic attach is defined by alist of flags and a function.
The following flags may be specified:
e init -attachwhenaprocessfor the very first time calls an interpreted function.
e break - attach whenever a process reaches a breakpoint.
e exit - atachwhen aprocessterminates.

When the specified event occurs, the function Funct i on will be called as:
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spawn( Modul e, Nane, [Pid | Args])

Pi d isthe pid of the process executing interpreted code.
stack _trace() -> Flag

stack_trace(Fl ag)
Types:
Flag = all | no_tail | false
Gets and sets how to save call framesin the stack. Saving call frames makes it possible to inspect the call chain of a
process, and is also used to emulate the stack trace if an error (an exception of class error) occurs.
« all -saveinformation about all current calls, that is, function calls that have not yet returned avalue. Thisis
the defaullt.

* no_tail -saveinformation about current calls, but discard previous information when atail recursive call is
made. This option consumes less memory and may be necessary to use for processes with long lifetimes and
many tail recursive calls.

« fal se -donot save any information about current calls.

break(Mdul e, Line) -> ok | {error, break_exi sts}

Types:
Module = atom()
Line=int()

Creates abreakpoint at Li ne in Modul e.

del et e_break(Mdul e, Line) -> ok

Types:
Module = atom()
Line=int()

Deletes the breakpoint located at Li ne in Modul e.

break_i n(Modul e, Nanme, Arity) -> ok | {error,function_not_found}

Types:
M odule = Name = atom()
Arity = int()

Creates a breakpoint at the first line of every clause of the Modul e: Nane/ Ari t y function.

del _break_ i n(Mdul e, Nanme, Arity) -> ok | {error,function_not_ found}

Types:
M odule = Name = atom()
Arity =int()

Deletes the breakpoints at the first line of every clause of the Modul e: Nane/ Ari t'y function.
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no_break() -> ok

no_break(Mbdul e) -> ok
Deletes all breakpoints, or all breakpointsin Mbdul e.

di sabl e_break(Mdul e, Line) -> ok

Types:
M odule = atom()
Line=int()

Makes the breakpoint at Li ne in Modul e inactive.

enabl e_break(Mdul e, Line) -> ok

Types:
Module = atom()
Line=int()

Makes the breakpoint at Li ne in Modul e active.

action_at_break(Mdul e, Line, Action) -> ok

Types:
Module = atom()
Line=int()

Action = enable | disable | delete
Setsthe trigger action of the breakpoint at Li ne in Modul e to Act i on.

test _at break(Mdul e, Line, Function) -> ok

Types:
Module = atom()
Line=int()

Function = {Module,Name}
Name = atom()

Sets the conditional test of the breakpoint at Li ne in Mbdul e to Functi on. The function must fulfill the
reguirements specified in the section Breakpoints above.

get _bi ndi ng(Var, Bindings) -> {value, Val ue} | unbound
Types:
Var = atom()
Bindings = term()
Value=term()
Retrieves the binding of Var . This function is intended to be used by the conditional function of a breakpoint.
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al | _breaks() -> [Break]

al | _breaks(Mdul e) -> [Break]
Types.
Break = {Point,Options}
Point = {Module,Line}
Module = atom()
Line=int()
Options = [Status, Trigger,null,Cond]|]
Status = active | inactive
Trigger = enable| disable | delete
Cond = null | Function
Function = {Module,Name}
Name = atom()

Gets dll breakpoints, or all breakpointsin Modul e.

snapshot () -> [ Snapshot]

Types:
Snapshot = {Pid, Function, Status, Info}
Pid = pid()

Function = {Module,Name,Ar gs}
Module = Name = atom()
Args=[term()]
Status =idle| running | waiting | break | exit | no_conn
Info={} | {ModuleLine} | ExitReason
Line=int()
ExitReason = term()
Gets information about all processes executing interpreted code.
e Pid - processidentifier.
e Functi on - first interpreted function called by the process.
e Stat us - current status of the process.
e | nf o - additional information.

St at us isone of:

« idl e -theprocessisno longer executing interpreted code. | nf o={} .

e runni ng -theprocessisrunning. | nf o={}.

e waiting-theprocessiswaiting at ar ecei ve. | nfo={}.

» break - process execution has been stopped, normally at a breakpoint. | nf o={ Modul e, Li ne}.
e exit -theprocesshasterminated. | nf o=Exi t Reason.

* no_conn - the connection is down to the node where the processis running. | nf o={}.

clear() -> ok
Clearsinformation about processes executing interpreted code by removing all information about terminated processes.
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continue(Pid) -> ok | {error,not_interpreted}

continue(X Y,Z) -> ok | {error,not _interpreted}

Types.
Pid = pid()
X=Y=2Z=int()

Resume process execution for Pi d, or for c: pi d( X, Y, Z) .
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